Microsoft Excel

Date and Time Functions
Introduction
Excel stores dates as sequential serial numbers, starting with January 1,
1900 (i.e., serial number 1) so that they can be used in calculations. The
serial number increases by 1 with each passing day. For example, the
serial number for the date June 15, 2020 in cell A1 below is 43997. The
serial number for the following day, June 16th, will be 43998 and so on.

If a serial number appears in a worksheet cell rather than the date, make
sure the cell contents are formatted as a Date. The date will also appear as a serial number when using
Show Formulas (Formulas→Show Formulas).

Enter Dates and Times
You can enter dates and times in cells using a variety of formats. In Excel, dates are values; therefore,
they align at the right cell margin. Use the following guidelines when entering dates and times:
•
•
•

Use either the forward slash (/) or the hyphen (-) as a date separator.
o Examples: 6/4/2020; 6-4-2020
Use a colon (:) as a time separator.
o Example: 11:05
Separate date and time formats with a space
o Example: 6/5/2020 11:05
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•

•
•
•
•

Use one of the following to enter a month:
o a number (e.g., 1=January, 2=February)
o the first three letters of the month’s name
o the entire month’s name,
Enter date and time values using either uppercase or lowercase letters
To display times using the 12-hour clock, include either am (or just a) or pm (or just p)
To enter the current date in a cell, press Ctrl+; (semicolon).
To enter the current time, press Ctrl+: (colon)

Table 2. Date and Time Formats
Format
m/d/yy
d-mmm-yy
d-mmm
mmm-yy

Example
2/25/21
25-Feb-21
25-Feb (Excel assumes the current year)
Feb-15 (Excel assumes the first day of the
month)
11:55:10 PM
11:55 PM

h:mm:ss AM/PM
H:mm AM/PM
Source: McFedries 2007, p. 200.

DATE Function
Description
•

The DATE function returns the sequential serial number that represents a particular date.

•

Use Excel's DATE function when you need to take three separate values and combine them to
form a date.

Syntax and Arguments
Syntax: DATE(year,month,day)
The DATE function syntax has the following arguments:
•

Year (Required). The value of the year argument can include one to four digits. Excel interprets
the year argument according to the date system your computer is using. By default, Microsoft
Excel for Windows uses the 1900 date system, which means the first date is January 1, 1900.
Tip: Use four digits for the year argument to prevent unwanted results. For example, “21” could
mean “1921” or “2021.” Four digit years prevent confusion.
o

If year is between 0 (zero) and 1899 (inclusive), Excel adds that value to 1900 to
calculate the year.
For example, DATE(108,1,2) returns January 2, 2008 (1900+108).

o

If year is between 1900 and 9999 (inclusive), Excel uses that value as the year.
For example, DATE(2008,1,2) returns January 2, 2008.

o

If year is less than 0 or is 10000 or greater, Excel returns the #NUM! error value.
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•

•

Month (Required). A positive or negative integer (whole number) representing the month of the
year from 1 to 12 (January to December).
o

If month is greater than 12, month adds that number of months to the first month in the
year specified.
For example, DATE(2021,14,2) returns the serial number representing February 2,
2022.

o

If month is less than 1, month subtracts the magnitude of that number of months, plus
1, from the first month in the year specified.
For example, DATE(2021,-3,2) returns the serial number representing September 2,
2020.

Day (Required). A positive or negative integer representing the day of the month from 1 to 31.
o

If day is greater than the number of days in the month specified, day adds that
number of days to the first day in the month.
For example, DATE(2021,1,35) returns the serial number representing February 4,
2021.

o

If day is less than 1, day subtracts the magnitude that number of days, plus one, from
the first day of the month specified.
For example, DATE(2021,1,-15) returns the serial number representing December 16,
2020.

For example: =DATE(C2,A2,B2) combines the year from cell C2, the month from cell A2, and the day
from cell B2 and puts them into one cell as a date. The example below shows the final result in cell D2.

Date Function

The Month (A2), Day (B2), and Year (C2) values are
combined into one date (D2).

Change the Date Format
To change the date format:
1. Right-click the cell(s) you want to change. On a Mac, Ctrl-click the cells.
2. On the Home tab click Format > Format Cells or press Ctrl+1 (Command+1 on a Mac).

3. Choose the Locale (location) and Date format you want.
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Calculate a Date Based on Another Date
You can use the DATE function to create a date that is based on another cell’s date. For example, you
can use the YEAR, MONTH, and DAY functions to create an anniversary date that’s based on another
cell. If an employee’s first day at work is 10/1/2016; the DATE function can be used to establish his fifth
year anniversary date:
1. The DATE function creates a date.
=DATE(YEAR(C2)+5,MONTH(C2),DAY(C2))
2. The YEAR function looks at cell C2 and
extracts "2012".
3. Then, "+5" adds 5 years, and establishes
"2017" as the anniversary year in cell D2.
4. The MONTH function extracts the "3" from C2. This establishes "3" as the month in cell D2.
5. The DAY function extracts "14" from C2. This establishes "14" as the day in cell D2.

Convert Text Strings and Numbers into Dates
If you open a file that came from another program, Excel will try to recognize dates within the data. But
sometimes the dates aren't recognizable. This is may be because the numbers don't resemble a typical
date, or because the data is formatted as text. If this is the case, you can use the DATE function to
convert the information into dates.
For example, in the following illustration, cell C2 contains a date that is in the format: YYYYMMDD. It is
also formatted as text. To convert it into a date, the DATE function was used in conjunction with the
LEFT, MID, and RIGHT functions.
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1. The DATE function creates a date.
=DATE(LEFT(C2,4),MID(C2,5,2),RIGHT(C2,2))
2. The LEFT function looks at cell C2 and takes the first
4 characters from the left. This establishes “2014” as
the year of the converted date in cell D2.
3. The MID function looks at cell C2. It starts at the 5th
character, and then takes 2 characters to the right. This
establishes “03” as the month of the converted date in
cell D2. Because the formatting of D2 set to Date, the “0” isn’t included in the final result.
4. The RIGHT function looks at cell C2 and takes the first 2 characters starting from the very right and
moving left. This establishes “14” as the day of the date in D2.

Increase or Decrease a Date by a Certain Number of Days
To increase or decrease a date by a certain number of days, add or subtract the number of days to the
value or cell reference containing the date.
In the example below, cell A5 contains the date that we want to increase and decrease by 7 days (the
value in C5).

DATEDIF Function
Description
The DATEDIF function calculates the number of days, months, or years between two dates.
The DATEDIF function is useful in formulas where you need to calculate an age.
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Syntax and Arguments
DATEDIF(start_date,end_date,unit)
Start_date. A date that represents the first, or starting, date of the period. Dates may be entered as text
strings within quotation marks (for example, "2001/1/30"), as serial numbers (for example, 36921, which
represents January 30, 2001, if you're using the 1900 date system), or as the results of other formulas
or functions (for example, DATEVALUE("2001/1/30")).
End_date. A date that represents the last, or ending, date of the period.
Unit. The type of information that you want returned:

Unit

Returns

"Y"
"M"
"D"
"MD"

The number of complete years in the period.
The number of complete months in the period.
The number of days in the period.
The difference between the days in start_date and end_date. The months and years of the
dates are ignored.Important: We don't recommend using the "MD" argument, as there are
known limitations with it. See the known issues section below.
The difference between the months in start_date and end_date. The days and years of the
dates are ignored
The difference between the days of start_date and end_date. The years of the dates are
ignored.

"YM"
"YD"

Examples
Start_date End_date Formula
1/1/2001

1/1/2003

6/1/2001

8/15/2002

6/1/2001

8/15/2002

Description (Result)

=DATEDIF(Start_date,End_date,"Y")

Two complete years in the period
(2)
=DATEDIF(Start_date,End_date,"D")
440 days between June 1, 2001,
and August 15, 2002 (440)`
=DATEDIF(Start_date,End_date,"YD") 75 days between June 1 and
August 15, ignoring the years of
the dates (75)

Known Issues
The "MD" argument may result in a negative number, a zero, or an inaccurate result. If you are trying to
calculate the remaining days after the last completed month, here is a workaround:
This formula subtracts the first day of the ending month
(5/1/2016) from the original end date in cell E17
(5/6/2016). Here's how it does this: First the DATE
function creates the date, 5/1/2016. It creates it using
the year in cell E17, and the month in cell E17. Then
the 1 represents the first day of that month. The result
for the DATE function is 5/1/2016. Then, we subtract
that from the original end date in cell E17, which is
5/6/2016. 5/6/2016 minus 5/1/2016 is 5 days.
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DATEVALUE Function
Description
The DATEVALUE function converts a date that is stored as text to a serial number that Excel
recognizes as a date. For example, the formula =DATEVALUE("1/1/2008") returns 39448, the serial
number of the date 1/1/2008. Remember, though, that your computer's system date setting may cause
the results of a DATEVALUE function to vary from this example
The DATEVALUE function is helpful in cases where a worksheet contains dates in a text format that
you want to filter, sort, or format as dates, or use in date calculations.
To view a date serial number as a date, you must apply a date format to the cell. Find links to more
information about displaying numbers as dates in the See Also section.

Syntax and Arguments
DATEVALUE(date_text)
The DATEVALUE function syntax has the following arguments:
•

Date_text (Required). Text that represents a date in an Excel date format, or a reference to a
cell that contains text that represents a date in an Excel date format.
For example, "1/30/2008" or "30-Jan-2008" are text strings within quotation marks that
represent dates.
Using the default date system in Microsoft Excel for Windows, the date_text argument must
represent a date between January 1, 1900 and December 31, 9999. The DATEVALUE function
returns the #VALUE! error value if the value of the date_text argument falls outside of this
range.
If the year portion of the date_text argument is omitted, the DATEVALUE function uses the
current year from your computer's built-in clock. Time information in the date_text argument is
ignored.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Data
11
3
2011
Formula
=DATEVALUE("8/22/2011")
=DATEVALUE("22-MAY-2011")
=DATEVALUE("2011/02/23")

Description
Serial number of a date entered as text.
Serial number of a date entered as text.
Serial number of a date entered as text.
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=DATEVALUE("5-JUL")

=DATEVALUE(A2 & "/" & A3 &
"/" & A4)

Serial number of a date entered as text, using the 1900
date system, and assuming the computer's built-in
clock returns 2011 as the current year.
Serial number of a date created by combining the
values in cells A2, A3, and A4.

39634

40850

DAY Function
Description
Returns the day of a date, represented by a serial number. The day is given as an integer ranging from
1 to 31.

Syntax and Arguments
DAY(serial_number)
The DAY function syntax has the following arguments:
•

Serial_number (Required). The date of the day you are trying to find. Dates should be entered
by using the DATE function, or as results of other formulas or functions.
For example, use DATE(2008,5,23) for the 23rd day of May, 2008.

Notes
Values returned by the YEAR, MONTH and DAY functions will be Gregorian values regardless of the
display format for the supplied date value. For example, if the display format of the supplied date is
Hijri, the returned values for the YEAR, MONTH and DAY functions will be values associated with the
equivalent Gregorian date.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Date
15-Apr-11
Formula
Description (Result)
Result
=DAY(A2) Day of the date in cell A2 (15) 15

DAYS Function
Description
Returns the number of days between two dates.
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Syntax and Arguments
DAYS(end_date, start_date)
The DAYS function syntax has the following arguments.
•

End_date (Required). Start_date and End_date are the two dates between which you want to
know the number of days.

•

Start_date (Required). Start_date and End_date are the two dates between which you want to
know the number of days.

Notes
•

If both date arguments are numbers, DAYS uses EndDate–StartDate to calculate the number of
days in between both dates.

•

If either one of the date arguments is text, that argument is treated as DATEVALUE(date_text)
and returns an integer date instead of a time component.

•

If date arguments are numeric values that fall outside the range of valid dates, DAYS returns the
#NUM! error value.

•

If date arguments are strings that cannot be parsed as valid dates, DAYS returns the #VALUE!
error value.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Data
12/31/2011
1/1/2011
Formula
Description
=DAYS("3/15/11","2/1/11") Finds the number of days between the end date (3/15/11) and
end date (2/1/11). When you enter a date directly in the
function, you need to enclose it in quotation marks. Result is
42.
=DAYS(A2,A3)
Finds the number of days between the end date in A2 and the
start date in A3 (364).

Result
42

DAYS360 Function
Description
The DAYS360 function returns the number of days between two dates based on a 360-day year
(twelve 30-day months), which is used in some accounting calculations. Use this function to help
compute payments if your accounting system is based on twelve 30-day months.
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Syntax and Arguments
DAYS360(start_date,end_date,[method])
The DAYS360 function syntax has the following arguments:
•

Start_date, end_date (Required). The two dates between which you want to know the number
of days. If start_date occurs after end_date, the DAYS360 function returns a negative number.
Dates should be entered by using the DATE function, or derived from the results of other
formulas or functions. For example, use DATE(2008,5,23) to return the 23rd day of May, 2008.
Problems can occur if dates are entered as text.

•

Method (Optional). A logical value that specifies whether to use the U.S. or European method
in the calculation.

Method

Defined

FALSE or
omitted

U.S. (NASD) method. If the starting date is the last day of a month, it becomes equal to
the 30th day of the same month. If the ending date is the last day of a month and the
starting date is earlier than the 30th day of a month, the ending date becomes equal to
the 1st day of the next month; otherwise the ending date becomes equal to the 30th day
of the same month.
European method. Starting dates and ending dates that occur on the 31st day of a
month become equal to the 30th day of the same month.

TRUE

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Dates
1-Jan-11
30-Jan-11
1-Feb-11
31-Dec-11
Formula
Description
=DAYS360(A3,A4) Number of days between 1/30/2011 and 2/1/2011, based on a 360day year.
=DAYS360(A2,A5) Number of days between 1/1/2011 and 12/31/2011, based on a 360day year.
=DAYS360(A2,A4) Number of days between 1/1/2011 and 2/1/2011, based on a 360-day
year.

Result
1
360
30

EDATE Function
Description
Returns the serial number that represents the date that is the indicated number of months before or
after a specified date (the start_date). Use EDATE to calculate maturity dates or due dates that fall on
the same day of the month as the date of issue.
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Syntax and Arguments
EDATE(start_date, months)
The EDATE function syntax has the following arguments:
•

Start_date (Required). A date that represents the start date. Dates should be entered by using
the DATE function, or as results of other formulas or functions. For example, use
DATE(2008,5,23) for the 23rd day of May, 2008. Problems can occur if dates are entered as
text.

•

Months (Required). The number of months before or after start_date. A positive value for
months yields a future date; a negative value yields a past date.

Notes
•

If start_date is not a valid date, EDATE returns the #VALUE! error value.

•

If months is not an integer, it is truncated.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Date
15-Jan-11
Formula
=EDATE(A2,1)
=EDATE(A2,-1)
=EDATE(A2,2)

Description
The date, one month after the date above
The date, one month before the date above
The date, two months after the date above

Result
15-Feb-11
15-Dec-10
15-Mar-11

EOMONTH Function
Description
Returns the serial number for the last day of the month that is the indicated number of months before or
after start_date. Use EOMONTH to calculate maturity dates or due dates that fall on the last day of the
month.

Syntax and Arguments
EOMONTH(start_date, months)
The EOMONTH function syntax has the following arguments:
•

Start_date (Required). A date that represents the starting date. Dates should be entered by
using the DATE function, or as results of other formulas or functions. For example, use
DATE(2008,5,23) for the 23rd day of May, 2008. Problems can occur if dates are entered as
text.
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•

Months (Required). The number of months before or after start_date. A positive value for
months yields a future date; a negative value yields a past date.
Note: If months is not an integer, it is truncated.

Notes
•

If start_date is not a valid date, EOMONTH returns the #NUM! error value.

•

If start_date plus months yields an invalid date, EOMONTH returns the #NUM! error value.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Date
1-Jan-11
Formula
=EOMONTH(A2,1)
=EOMONTH(A2,3)

Description
Date of the last day of the month, one month after the date in A2.
Date of the last day of the month, three months before the date in
A2.

Result
2/28/2011
10/31/2010

HOUR Function
Description
Returns the hour of a time value. The hour is given as an integer, ranging from 0 (12:00 A.M.) to 23
(11:00 P.M.).

Syntax and Arguments
HOUR(serial_number)
The HOUR function syntax has the following arguments:
•

Serial_number (Required). The time that contains the hour you want to find. Times may be
entered as text strings within quotation marks (for example, "6:45 PM"), as decimal numbers (for
example, 0.78125, which represents 6:45 PM), or as results of other formulas or functions (for
example, TIMEVALUE("6:45 PM")).

Notes
Time values are a portion of a date value and represented by a decimal number (for example, 12:00
PM is represented as 0.5 because it is half of a day).

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.
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Time
0.75
7/18/2011 7:45
4/21/2012
Formula
=HOUR(A2)
=HOUR(A3)
=HOUR(A4)

Description
Returns 75% of 24 hours
Returns the hour portion of the date/time value.
A date with no time portion specified is considered 12:00 AM, or 0 hours.

Result
18
7
0

SOWEEKNUM Function
Description
Returns number of the ISO week number of the year for a given date.

Syntax and Arguments
ISOWEEKNUM(date)
The ISOWEEKNUM function syntax has the following arguments.
•

Date (Required). Date is the date-time code used by Excel for date and time calculation.

Notes
•

If the date argument is not a valid number, ISOWEEKNUM returns the #NUM! error value.

•

If the date argument is not a valid date type, ISOWEEKNUM returns the #VALUE! error value.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Date
3/9/2012
Formula
Description
=ISOWEEKNUM(A2) Number of the week in the year that 3/9/2012 occurs, based on
weeks beginning on the default, Monday (10).

MINUTE Function
Description
Returns the minutes of a time value. The minute is given as an integer, ranging from 0 to 59.
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Syntax and Arguments
MINUTE(serial_number)
The MINUTE function syntax has the following arguments:
•

Serial_number (Required). The time that contains the minute you want to find. Times may be
entered as text strings within quotation marks (for example, "6:45 PM"), as decimal numbers (for
example, 0.78125, which represents 6:45 PM), or as results of other formulas or functions (for
example, TIMEVALUE("6:45 PM")).

Notes
Time values are a portion of a date value and represented by a decimal number (for example, 12:00
PM is represented as 0.5, since it is half of a day).

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Time
12:45:00 PM
Formula
Description
Result
=MINUTE(A2)
Minute portion of the time in A2. 45

MONTH Function
Description
Returns the month of a date represented by a serial number. The month is given as an integer, ranging
from 1 (January) to 12 (December).

Syntax
MONTH(serial_number)
The MONTH function syntax has the following arguments:
•

Serial_number (Required). The date of the month you are trying to find. Dates should be
entered by using the DATE function, or as results of other formulas or functions. For example,
use DATE(2008,5,23) for the 23rd day of May, 2008. Problems can occur if dates are entered
as text.

Notes
Values returned by the YEAR, MONTH and DAY functions will be Gregorian values regardless of the
display format for the supplied date value. For example, if the display format of the supplied date is
Hijri, the returned values for the YEAR, MONTH and DAY functions will be values associated with the
equivalent Gregorian date.
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Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Date
15-Apr-11
Formula
Description
Result
=MONTH(A2) Month of the date in cell A2

NETWORKDAYS Function
Description
Returns the number of whole working days between start_date and end_date. Working days exclude
weekends and any dates identified in holidays. Use NETWORKDAYS to calculate employee benefits
that accrue based on the number of days worked during a specific term.
Tip: To calculate whole workdays between two dates by using parameters to indicate which and how
many days are weekend days, use the NETWORKDAYS.INTL function.

Syntax and Arguments
NETWORKDAYS(start_date, end_date, [holidays])
The NETWORKDAYS function syntax has the following arguments:
•

Start_date (Required). A date that represents the start date.

•

End_date (Required). A date that represents the end date.

•

Holidays (Optional). An optional range of one or more dates to exclude from the working
calendar, such as state and federal holidays and floating holidays. The list can be either a range
of cells that contains the dates or an array constant of the serial numbers that represent the
dates.

Important: Dates should be entered by using the DATE function, or as results of other formulas or
functions. For example, use DATE(2012,5,23) for the 23rd day of May, 2012. Problems can occur if
dates are entered as text.

Notes
•

If any argument is not a valid date, NETWORKDAYS returns the #VALUE! error value.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.
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Date

Description

10/1/2012
3/1/2013
11/22/2012
12/4/2012
1/21/2013
Formula
=NETWORKDAYS(A2,A3)

Start date of project
End date of project
Holiday
Holiday
Holiday
Description
Number of workdays between the start (10/1/2012) and
end date (3/1/2013).
=NETWORKDAYS(A2,A3,A4)
Number of workdays between the start (10/1/2012) and
end date (3/1/2013), with the 11/22/2012 holiday as a
non-working day.
=NETWORKDAYS(A2,A3,A4:A6) Number of workdays between the start (10/1/2012) and
end date (3/1/2013), with the three holidays as nonworking days.

Result
110
109

NOW function
Description
Returns the serial number of the current date and time. If the cell format was General before the
function was entered, Excel changes the cell format so that it matches the date and time format of your
regional settings. You can change the date and time format for the cell by using the commands in the
Number group of the Home tab on the Ribbon.
The NOW function is useful when you need to display the current date and time on a worksheet or
calculate a value based on the current date and time, and have that value updated each time you open
the worksheet.
Note: If the NOW function does not update cell values when you expect it to, you might need to change
settings that control when the workbook or worksheet recalculates. These settings can be changed in
Control Panel for the Excel desktop application.

Syntax and Arguments
NOW()
The NOW function syntax has no arguments.

Notes
•

Numbers to the right of the decimal point in the serial number represent the time; numbers to
the left represent the date. For example, the serial number 0.5 represents the time 12:00 noon.

•

The results of the NOW function change only when the worksheet is calculated or when a
macro that contains the function is run. It is not updated continuously.

Page 16 of 28

Microsoft Excel: Date and Time Functions

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Formula

Description

Result

=NOW()
=NOW()-0.5
=NOW()+7

Returns the current date and time.
Returns the date and time 12 hours ago (-0.5 days ago).
Returns the date and time 7 days in the future.

=NOW()2.25

Returns the date and time 2 days and 6 hours ago (-2.25 days
ago).

11/6/2011 19:03
11/6/2011 7:03
11/13/2011
19:03
11/4/2011 13:03

SECOND function
Description
Returns the seconds of a time value. The second is given as an integer in the range 0 (zero) to 59.

Syntax
SECOND(serial_number)
The SECOND function syntax has the following arguments:
•

Serial_number (Required). The time that contains the seconds you want to find. Times may be
entered as text strings within quotation marks (for example, "6:45 PM"), as decimal numbers (for
example, 0.78125, which represents 6:45 PM), or as results of other formulas or functions (for
example, TIMEVALUE("6:45 PM")).

Notes
Time values are a portion of a date value and represented by a decimal number (for example, 12:00
PM is represented as 0.5 because it is half of a day).

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Data
Time
4:48:18 PM
4:48 PM
Formula
Description
R esult
=SECOND(A3) Seconds in the first time (18)
18
=SECOND(A4) Seconds in the second time (0) 0
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TIME function
Description
Returns the decimal number for a particular time. If the cell format was General before the function was
entered, the result is formatted as a date.
The decimal number returned by TIME is a value ranging from 0 (zero) to 0.99988426, representing the
times from 0:00:00 (12:00:00 AM) to 23:59:59 (11:59:59 P.M.).

Syntax and Arguments
TIME(hour, minute, second)
The TIME function syntax has the following arguments:
•

Hour (Required). A number from 0 (zero) to 32767 representing the hour. Any value greater
than 23 will be divided by 24 and the remainder will be treated as the hour value. For example,
TIME(27,0,0) = TIME(3,0,0) = .125 or 3:00 AM.

•

Minute (Required). A number from 0 to 32767 representing the minute. Any value greater than
59 will be converted to hours and minutes. For example, TIME(0,750,0) = TIME(12,30,0) =
.520833 or 12:30 PM.

•

Second (Required). A number from 0 to 32767 representing the second. Any value greater
than 59 will be converted to hours, minutes, and seconds. For example, TIME(0,0,2000) =
TIME(0,33,22) = .023148 or 12:33:20 AM

Notes
Time values are a portion of a date value and represented by a decimal number (for example, 12:00
PM is represented as 0.5 because it is half of a day).

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Hour

Minute

Second

12
16
Formula
=TIME(A2,B2,C2)

0
48
Description
Decimal part of a day, for the time specified in row 2 (12 hours, 0,
minutes, 0 seconds)
=TIME(A3,B3,C3) Decimal part of a day, for the time specified in row 3 (16 hours, 48
minutes, 10 seconds)
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Result
0.5
0.7001157

Microsoft Excel: Date and Time Functions

TIMEVALUE function
Description
Returns the decimal number of the time represented by a text string. The decimal number is a value
ranging from 0 (zero) to 0.99988426, representing the times from 0:00:00 (12:00:00 AM) to 23:59:59
(11:59:59 P.M.).

Syntax and Arguments
TIMEVALUE(time_text)
The TIMEVALUE function syntax has the following arguments:
•

Time_text (Required). A text string that represents a time in any one of the Microsoft Excel
time formats; for example, "6:45 PM" and "18:45" text strings within quotation marks that
represent time.

Notes
•

Date information in time_text is ignored.

•

Time values are a portion of a date value and represented by a decimal number (for example,
12:00 PM is represented as 0.5 because it is half of a day).

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Formula

Description

Result

=TIMEVALUE("2:24 AM")

Decimal part of a day, with only the time
specified.
Decimal part of a day, with date and time
specified.

0.10

=TIMEVALUE("22-Aug-2011 6:35
AM")

0.2743

TODAY Function
Description
Returns the serial number of the current date. The serial number is the date-time code used by Excel
for date and time calculations. If the cell format was General before the function was entered, Excel
changes the cell format to Date. If you want to view the serial number, you must change the cell format
to General or Number.
The TODAY function is useful when you need to have the current date displayed on a worksheet,
regardless of when you open the workbook. It is also useful for calculating intervals. For example, if you
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know that someone was born in 1963, you might use the following formula to find that person's age as
of this year's birthday:
= YEAR( TODAY())-1963
This formula uses the TODAY function as an argument for the YEAR function to obtain the current
year, and then subtracts 1963, returning the person's age.
Note: If the TODAY function does not update the date when you expect it to, you might need to change
the settings that control when the workbook or worksheet recalculates. On the File tab, click Options,
and then in the Formulas category under Calculation options, make sure that Automatic is selected.

Syntax and Arguments
TODAY()
The TODAY function syntax has no arguments.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Formula

Description

Result

=TODAY()
=TODAY()+5

Returns the current date.
Returns the current date plus 5 days. For example, if
the current date is 1/1/2012, this formula returns
1/6/2012.
Returns the number of days between the current date
and 1/1/2030. Note that cell A4 must be formatted as
General or Number for the result to display correctly.
Returns the current day of the month (1 - 31).
Returns the current month of the year (1 - 12). For
example, if the current month is May, this formula
returns 5.

12/1/2011
12/6/2011

=DATEVALUE("1/1/2030")TODAY()
=DAY(TODAY())
=MONTH(TODAY())

1/31/1918

1
12

WEEKDAY Function
Description
Returns the day of the week corresponding to a date. The day is given as an integer, ranging from 1
(Sunday) to 7 (Saturday), by default.
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Syntax and Arguments
WEEKDAY(serial_number,[return_type])
The WEEKDAY function syntax has the following arguments:
•

Serial_number (Required). A sequential number that represents the date of the day you are
trying to find. Dates should be entered by using the DATE function, or as results of other
formulas or functions. For example, use DATE(2008,5,23) for the 23rd day of May, 2008.
Problems can occur if dates are entered as text.

•

Return_type (Optional). A number that determines the type of return value.

Return_type
1 or
omitted
2
3
11
12
13
14
15
16
17

Number returned
Numbers 1 (Sunday) through 7 (Saturday). Behaves like previous versions of
Microsoft Excel.
Numbers 1 (Monday) through 7 (Sunday).
Numbers 0 (Monday) through 6 (Sunday).
Numbers 1 (Monday) through 7 (Sunday).
Numbers 1 (Tuesday) through 7 (Monday).
Numbers 1 (Wednesday) through 7 (Tuesday).
Numbers 1 (Thursday) through 7 (Wednesday).
Numbers 1 (Friday) through 7 (Thursday).
Numbers 1 (Saturday) through 7 (Friday).
Numbers 1 (Sunday) through 7 (Saturday).

Notes
•

If serial_number is out of range for the current date base value, a #NUM! error is returned.

•

If return_type is out of the range specified in the table above, a #NUM! error is returned.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Data
2/14/2008
Formula
=WEEKDAY(A2)
=WEEKDAY(A2, 2)
=WEEKDAY(A2, 3)

Description (Result)
Day of the week, with numbers 1 (Sunday) through 7 (Saturday) (5)
Day of the week, with numbers 1 (Monday) through 7 (Sunday) (4)
Day of the week, with numbers 0 (Monday) through 6 (Sunday) (3)

Result
5
4
3

WEEKNUM Function
Description
Returns the week number of a specific date. For example, the week containing January 1 is the first
week of the year, and is numbered week 1.
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There are two systems used for this function:
•

System 1: The week containing January 1 is the first week of the year, and is numbered week
1.

•

System 2: The week containing the first Thursday of the year is the first week of the year, and is
numbered as week 1. This system is the methodology specified in ISO 8601, which is
commonly known as the European week numbering system.

Syntax and Arguments
WEEKNUM(serial_number,[return_type])
The WEEKNUM function syntax has the following arguments:
•

Serial_number (Required). A date within the week. Dates should be entered by using the
DATE function, or as results of other formulas or functions. For example, use DATE(2008,5,23)
for the 23rd day of May, 2008. Problems can occur if dates are entered as text.

•

Return_type (Optional). A number that determines on which day the week begins. The default
is 1.

Return_type
1 or omitted
2
11
12
13
14
15
16
17
21

Week begins on
Sunday
Monday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
Sunday
Monday

System
1
1
1
1
1
1
1
1
1
2

Notes
•

If Serial_number is out of range for the current date base value, a #NUM! error is returned.

•

If Return_type is out of the range specified in the table above, a #NUM! error is returned.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Data
3/9/2012
Formula
=WEEKNUM(A2)

Description
Number of the week in the year that 3/9/2012 occurs, based on weeks
beginning on Sunday (default).
=WEEKNUM(A2,2) Number of the week in the year that 3/9/2012 occurs, based on a
week beginning on Monday (the second argument, 2).
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WORKDAY Function
Description
Returns a number that represents a date that is the indicated number of working days before or after a
date (the starting date). Working days exclude weekends and any dates identified as holidays. Use
WORKDAY to exclude weekends or holidays when you calculate invoice due dates, expected delivery
times, or the number of days of work performed.
Tip: To calculate the serial number of the date before or after a specified number of workdays by using
parameters to indicate which and how many days are weekend days, use the WORKDAY.INTL
function.

Syntax and Arguments
WORKDAY(start_date, days, [holidays])
The WORKDAY function syntax has the following arguments:
•

Start_date (Required). A date that represents the start date.

•

Days (Required). The number of nonweekend and nonholiday days before or after start_date.
A positive value for days yields a future date; a negative value yields a past date.

•

Holidays (Optional). An optional list of one or more dates to exclude from the working
calendar, such as state and federal holidays and floating holidays. The list can be either a range
of cells that contain the dates or an array constant of the serial numbers that represent the
dates.

Important: Dates should be entered by using the DATE function, or as results of other formulas or
functions. For example, use DATE(2008,5,23) for the 23rd day of May, 2008. Problems can occur if
dates are entered as text.

Notes
•

If any argument is not a valid date, WORKDAY returns the #VALUE! error value.

•

If start_date plus days yields an invalid date, WORKDAY returns the #NUM! error value.

•

If days is not an integer, it is truncated.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Data
10/1/2008
151
11/26/2008
12/4/2008

Start date
Days to completion
Holiday
Holiday
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1/21/2009
Formula
=WORKDAY(A2,A3)
=WORKDAY(A2,A3,A4:A6)

Holiday
Description (Result)
Date 151 workdays from the start date (4/30/2009)
Date 151 workdays from the start date, excluding holidays
(5/5/2009)

Result
4/30/2009
5/5/2009

WORKDAY.INTL function
Description
Returns the serial number of the date before or after a specified number of workdays with custom
weekend parameters. Weekend parameters indicate which and how many days are weekend days.
Weekend days and any days that are specified as holidays are not considered as workdays.

Syntax and Arguments
WORKDAY.INTL(start_date, days, [weekend], [holidays])
The WORKDAY.INTL function syntax has the following arguments:
•

Start_date (Required). The start date, truncated to integer.

•

Days (Required). The number of workdays before or after the start_date. A positive value
yields a future date; a negative value yields a past date; a zero value yields the start_date. Dayoffset is truncated to an integer.

•

Weekend (Optional). Indicates the days of the week that are weekend days and are not
considered working days. Weekend is a weekend number or string that specifies when
weekends occur.
Weekend number values indicate the following weekend days:

weekend-number
1 or omitted
2
3
4
5
6
7
11
12
13
14
15
16
17

Weekend days
Saturday, Sunday
Sunday, Monday
Monday, Tuesday
Tuesday, Wednesday
Wednesday, Thursday
Thursday, Friday
Friday, Saturday
Sunday only
Monday only
Tuesday only
Wednesday only
Thursday only
Friday only
Saturday only
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Weekend string values are seven characters long and each character in the string represents a day of
the week, starting with Monday. 1 represents a non-workday and 0 represents a workday. Only the
characters 1 and 0 are permitted in the string. 1111111 is an invalid string.
For example, 0000011would result in a weekend that is Saturday and Sunday.
•

Holidays (Optional). An optional set of one or more dates that are to be excluded from the
working day calendar. Holidays shall be a range of cells that contain the dates, or an array
constant of the serial values that represent those dates. The ordering of dates or serial values in
holidays can be arbitrary.

Notes
•

If start_date is out of range for the current date base value, WORKDAY.INTL returns the #NUM!
error value.

•

If any date in holidays is out of range for the current date base value, WORKDAY.INTL returns
the #NUM! error value.

•

If start_date plus day-offset yields an invalid date, WORKDAY.INTL returns the #NUM! error
value.

•

If a weekend string is of invalid length or contains invalid characters, WORKDAY.INTL returns
the #VALUE! error value.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Formula

Description

=WORKDAY.INTL(DATE(2012,1,1),30,0)

Using a 0 for the
Weekend argument
results in a #NUM!
error.
=WORKDAY.INTL(DATE(2012,1,1),90,11)
Finds the date 90
workdays from
1/1/2012, counting
only Sundays as a
weekend day
(Weekend argument
is 11).
=TEXT(WORKDAY.INTL(DATE(2012,1,1),30,17),"m/dd/yyyy") Uses the TEXT
function to format the
resulting serial
number (40944) in a
"m/dd/yyyy" format.
Finds the date 30
workdays from
1/1/2012, counting
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41013
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only Saturdays as a
weekend day
(Weekend argument
is 17).

YEAR Function
Description
Returns the year corresponding to a date. The year is returned as an integer in the range 1900-9999.

Syntax and Arguments
YEAR(serial_number)
The YEAR function syntax has the following arguments:
•

Serial_number (Required). The date of the year you want to find. Dates should be entered by
using the DATE function, or as results of other formulas or functions. For example, use
DATE(2008,5,23) for the 23rd day of May, 2008. Problems can occur if dates are entered as
text.

Notes
Values returned by the YEAR, MONTH and DAY functions will be Gregorian values regardless of the
display format for the supplied date value. For example, if the display format of the supplied date is
Hijri, the returned values for the YEAR, MONTH and DAY functions will be values associated with the
equivalent Gregorian date.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Data
Date
7/5/2008
7/5/2010
Formula
Description (Result)
Result
=YEAR(A3) Year of the date in cell A3 (2008) 2008
=YEAR(A4) Year of the date in cell A4 (2010) 2010
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YEARFRAC Function
Description
Calculates the fraction of the year represented by the number of whole days between two dates (the
start_date and the end_date). Use the YEARFRAC worksheet function to identify the proportion of a
whole year's benefits or obligations to assign to a specific term.

Syntax and Arguments
YEARFRAC(start_date, end_date, [basis])
The YEARFRAC function syntax has the following arguments:
•

Start_date (Required). A date that represents the start date.

•

End_date (Required). A date that represents the end date.

•

Basis (Optional). The type of day count basis to use.

Basis

Day count basis

0 or omitted
1
2
3
4

US (NASD) 30/360
Actual/actual
Actual/360
Actual/365
European 30/360

Notes
•

All arguments are truncated to integers.

•

If start_date or end_date are not valid dates, YEARFRAC returns the #VALUE! error value.

•

If basis < 0 or if basis > 4, YEARFRAC returns the #NUM! error value.

Example
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For
formulas to show results, select them, press F2, and then press Enter. If you need to, you can adjust
the column widths to see all the data.

Data

Description

1/1/2012
7/30/2012
Formula
=YEARFRAC(A2,A3)

Start date
End date
Description
Fraction of the year between 1/1/2012 and 7/30/12, omitting
the Basis argument.
=YEARFRAC(A2,A3,1) Fraction between same dates, using the Actual/Actual basis
argument. Because 2012 is a Leap year, it has a 366 day
basis.
=YEARFRAC(A2,A3,3) Fraction between same dates, using the Actual/365 basis
argument. Uses a 365 day basis.
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